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What is Emgu CV?

A cross platform .Net wrapper to the OpenCV
image processing library.

Allowing OpenCV functions to be called from
.NET compatible languages such as C#, VB,
VC++, etc.

The wrapper can run on Windows, Linux, Mac
OS X, iPhone, iPad and Android devices.
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What is Open CV? U

OpenCV

Open Source Computer Vision Library

A library of functions mainly aimed at real-time
computer vision / image processing

Developed by Intel, and now supported by
Willow Garage and Itseez

Free
The
It wi
acce

for use under the open source BSD license
ibrary is cross-platform

| use proprietary optimized routines to
erate itself for Intel processors
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What can we do? — Sample project

Shape detection

A
e



http://www.emgu.com/wiki/images/Opencvpic3sample.png
http://www.emgu.com/wiki/images/Opencvpic3sample.png

Lawrence
Tech

What can we do? — Sample project

Stop sign detection

Traffic Sign Recognition

Stop Sign [49,49];

File: | [ Load Image ]

Stop Sign Detection time; 45 8502 mili-zeconds

sTOPJ
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What can we do? — Sample projects

Fage detection

17 W Y o



http://www.emgu.com/wiki/images/PedestrianDetectionExample1.png
http://www.emgu.com/wiki/images/PedestrianDetectionExample1.png

Lawrence

What can we do? — Sample projects: Tech

License Plate Recognition (LPR)
Optical Character Recognition (OCR)

TesseractDotnet Example |:||:| E|

Wisw |1-01-01075-5

OCR Resuft: | wusn 1-07-01075-5

.G\ data\test. traineddats loaded Load Imzge... | l Exit ]




HOW TO SETUP EMGU CV



Downloading Emgu

Download Emgu Version 2.4.9-beta from the

following link
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Le! libemgucv-windows-universal-cuda-2.9.0.1922-beta

® http://sourceforge.net/projects/emgucv/files/emgucv

® Choose the correct version for the your OS

Looking for the latest version? Download libemgucv-windows-universal-cuda-2.9.0.1922-beta.exe

(214.0 MB)

Home / emgucy / 2.4.9-beta
Name #

4 Parent folder

libemgucv-ios-2.4.9.1933-r3-simulat...
libemgucv-windows-universal-cuda-...
libemgucv-windows-universal-cuda-...
demo.emgu.cv.Android-2.4.9.1910-b...

libemgucv-android-x86-simulator-onl...

Totals: 5 ltems

Modified #

2014-04-15

2013-09-26

2013-09-26

2013-08-31

2013-08-31

Size *

22.3 MB

511.3 MB

214.0 MB

50.6 MB

24.1 MB

822.2 MB

Downloads / Week #

55| e

1083

1,150

Same!

/
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Installing Emgu

Once downloaded, run the

libemgucv-windows-universal-cuda-2.9.0.1922-beta , @ X E

If you choose default options, it will be installed
under C:\Emgu\

Note: This instruction is for LTU laptop (Lenovo
Yoga) with 64 bit OS

10
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Emqgu Setup In VS (Step 1)
First, select “Visual C#”
Create a new Windows Forms Application, “HiEmgu”
New Project
P Recent | .NET Framework 4.5 ~| Sort by: | Default M= Search Installed Templ:

4 |nstalled - .
@mdows Forms ApplmatmD Visual C# Type: Visual C#
4 Templates :

A project for creating

L~71sual Ba WPF Application Visual C# Windows Forms user |
4 Visual C# ‘-)
CH
Witidows Store ﬁ i .

Console Application Visual C#
Windows
C#
P Web 5‘_1 ASP.NET Web Application Visual C#
I Office/SharePoint
Ci
Cloud ﬁ; ! Class Library Visual C#
LightSwitch
Reporting ﬁ Portable Class Library Visual C#
Silverlight
Test —ct
N | Blank App (XAML) Visual C# -
AN Fal -
b Online Click here to go online and find templates.

Name: |HiEmgu| ) |
——
Location: |C:\Users\cchung\Goog|e Drive\cSharp\ v|

Solution name: HiEmgu Create directory for so

[] Add to source control




Emqgu Setup (Step

Lawrence
Tech

2) - Adding

ImageBox Control in Visual Studio (i), Once

http://www.emagu.com/wiki/index.php/

Add ImageBox Control

In Designer view /
Toolbox, right click in the
empty space of 'General’
column. This should pop
up a selection menu,
where 'Choose ltems'
selection is available.

In case you need to re-importing ImageBox
control, right click on “General’ and click
on “Reset Toolbox™

Dq HiEmgu - Microsoft Visual Studio
FILE EDIT VIEW PROJECT BUILD DEBUG TEAM  TOOLS

B2 M| - < posart- - |Debug

Toolbox

Search Toolbox P~

> All Windows Forms
> Common Controls

> Containers

P Menus & Toolbars

I Data

P Components

> Printing

> Dialogs

> Reporting

> WPF Interoperability
_

Paste Ctrl+V

$90IN0S B1eQ  XO0Q|00| J210|dX3 Jonias |EEEE

There &

ite v List View

Show All

Choose Items...

Sort Items Alphabetically
Reset Toolbox

Add Tab

Delete Tab

Rename Tab
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Emgu Setup (Step 2) - Adding
ImageBox Control in Visual Studio (i1) ), Once
Click on the 'Browse..' button.

Choose Toolbox Items

> IEM

System.Activities Components

WPF Components

@i

Language: Invariant Language (Invariant Country)

Version:  4.0.0.0

System.Workflow.ComponentModel
Microsoft. TeamFoundation.Controls
Microsoft.VisualBasic.Compatibility.
Microsoft.VisualBasic.Compatibility.

Nationallnstruments.TestStand.Inter

Silverlight Components Windows Phone Components Windows XAML Components
.NET Framework Components COM Components
Name & Namespace Assembly Name
[¢] AccessDataSource System.Web.UlL.WebControls System.Web
[]  Activity System.Workflow.ComponentModel
[] AddGroupControl Microsoft. TeamFoundation.Controls.WinForms
[] ADODC Microsoft.VisualBasic.Compatibility.VB6
[] ADODCArray Microsoft.VisualBasic.Compatibility.VB6
[] AdRotator System.Web.Ul.MaobileControls System.Web.Mobile
[« AdRotator System.Web.UL.WebControls System.Web
[/l AppearanceEditorPart System.Web.Ul.WebControls.WebParts System.Web
[] ApplicationMgr Nationallnstruments.TestStand.Interop.UL.AX
Filter:
AccessDataSource

Clear

Browse...

OK

Cancel

Reset
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Emqgu Setup (Step 2) - Adding
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ImageBox Control in Visual Studio (iii) ), Once

Select Emgu.CV.Ul.dll file from: C:\Emgu\emgucv-

windows-universal-cuda 2.9.0.1922\bin

Click the 'Open’ button

Now you should notice the ImageBox control
has been added to the 'Choose Toolbox Items'
dialog. Click 'Ok’.

[ Image
[ ImageBox
[ ImageButton

Filter:

HistogramBox

&3
Vers

ion:  2.9.0.1922

System.Web.UL.WebControls
Emgu.CV.UI
System.Web.Ul.WebControls

Language: Invariant Language (Invariant Country)

System.Web
Emgu.CV.UI
System.Web

If you get an
error
message
here,
re-launch
Visual Studio

14
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Emgu Setup In VS (Step 3)

Drag and drop an ImageBox component on to
the current Windows Form

| ' - .

Toolbox

Search Toolbox

$321N0S eleq

I All Windows Forms
P Common Controls
I Containers
F Menus & Toolbars
P Data
I Components
P Printing
I Dialogs
> Reporting
I WPF Interoperability
4 General

Pointer

HistogramBox

, ImageBox
.',-l MatrixBox
.',-I PanAndZoomPictureBox

Check the default aspect ratio of your
camera. Yoga uses 16:9, (320, 180)

I F JowaiL

[rEwuy T s E

Form1

Solution Explorer
Sl o-2ndBd
Search Solution Explorer (Ctrl+;) P~

fa] Solution 'HiEmgu' (1 project)
4 HiEmgu
P M Properties
P =W References
¢.] App.config
4 Form1.cs
> T Form1.Designer.cs
™ Form1.resx
P ¥z Form1
P €% Program.cs

Solution Ex... REEl=Y oo e EERAVTAN

Properties + I X

imageBox1 Emgu.CV.UlImageBox v

MDD F

MaximumSize 0,0 -

MinimumSize 0,0

Padding 0,000

Size 320, 180 -
15



Lawrence
Tech

Setup path for the Project *.DLL
References (Step 4, 1), Once

Search “Edit environment variables” and click
on

Search

Everywhere

edit environment variables

‘ g Edit environment variables for
. your account

16
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Setup path for the Project *DLL
References (Step 4, ii), Once

Environment Variables -

Click on Edit... button

User variables for cchung

C:\Program Files\Intel\WiFi\bin\;C:\Pro...

TEMP %USERPROFILE%\AppData\Local\Temp Carefu”y add a SemICOIOn (’) at

TMP %USERPROFILE%.\AppData'Local\Temp

the end of the Path variable.

New... Edit... Delete

Then append the path to the

Variable Value ~

ADSKFLEX_LICE... cobal compus.u.edo Emgu CV ..\bin\x64 folder after

AGSDESKTOPIAVA C:\Program Files (x86)\ArcGIS\Desktop...

CM2014DIR C:\Program Files (x86)\Commaon Files\... h ' I
ComSpec C:\Windows\system32\cmd. exe t e Se m I CO On .

L

Warning: Keep the current!!!!!

For example:

;C:\Emgu\emgucv-windows-universal-cuda 2.9.0.1922\bin\x64

17
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Emgu Setup (Step 5) project references (i)

Reference the three .dll files in the project by
right clicking the ‘References’ folder and
selecting ‘Add Reference’

M Solution Explorer
Al o-endip
Search Solution Explorer (Ctrl+;) pe

b M Properties
saeH | References
)1 App.config
ilf cublas64 55.dll
il§ cudart64 55.dll
il§ cuffte4_55.dll
il cvextern.dll

c=| Form1.cs

ilE nppc64 55.dll

Add Reference...
Add Service Reference...

m Manage NuGet Packages...

Scope to This
New Solution Explorer View




following files:
Emgu.CV
E m g u ° CV. U I = [:l.an;;gu.CV.DebuggerVisualizers.V52008.d||

“ Emgu.CV.DebuggerVisualizers.vs2010.dll
« Emgu.CV.DebuggerVisualizers.vVs2012.dll
. Emgu.Cv.dll

“ Emgu.CV.GPUdII

“ Emgu.CV.MLdII

“ Emgu.CV.OCR.dII

~ Emgu.CV.OpenCLdll

lcv-windows-universal-cuda 2.9.0.1922 » bin

Emgu.Util

Select the files to reference...

v o

Date modified

9/23/2013 8:41 AM
9/23/2013 8:41 AM
9/23/2013 8:41 AM
9/23/2013 8:41 AM
9/23/2013 8:41 AM
9/23/2013 8:41 AM
9/23/2013 8:41 AM
9/23/2013 8:41 AM
9/23/2013 8:41 AM

Search bin

Lawrence

Emgu Setup (Step: 5) project references (ii)

Using the ‘Browse’ tab, navigate to C:\Emgu\emgucv-
windows-universal-cuda 2.9.0.1922\bin and select the

Type

Tech

Application extensi...

Application extensi...

Application extensi...

Application extensi...

Application extensi...

Application extensi...

Application extensi...

Application extensi...

Application extensi...

Th e n Cl iC k O n ‘ = Emgu.CV.Stitching.dll

9/23/2013 8:41 AM

Application extensi...

9/23/2013 8:41 AM

Application extensi...

\ ~ Emgu.Utildll

Add -> OK

9/23/2013 8:41 AM

Application extensi...

B ' Example.CameraCapture
v <

button.

ame: "Emgu.CV.dIl" "Emgu.CV.ULdII" "Emgu.Util.dIl"

9/23/2013 8:41 AM

Application

>

10



Emqgu Setup In VS (Step: 6)

platform target (i)

The final step is to
change the ‘Platform
target’ to x64, if you are
on a 64 bit OS

From the ‘Project’ menu
select

ProjectName
Properties...

Lawrence
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Dq HiEmgu - Microsoft Visual Studio

FILE EDIT  VIEW | PROJECT | BUILD

Add Windows Form...
Add User Control...
Add Component...

Add Class...

Add New Data Source...

« &0 E

Add New Item...
Add Existing Item...

oo

Exclude From Project

‘2 Show All Files

Add Reference...
Add Service Reference...
£} Setas StartUp Project
m Manage NuGet Packages...
[ Enable NuGet Package Restore
€2 Refresh Project Toolbox ltems

&  HiEmgu Properties...

DEBUG  TEAM

I

1* =

Form
Ctrl+sShift+A |
Shift+Alt+A

]

20
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Emqgu Setup in VS (Step: 6)
platform target (ii)

Select x64 for the ‘Platform target’ in the Build
tab, then click on Save.

Dd HiEmgu - Microsoft Visugz
FILE EDIT  VIEW _RR

SIS le [V ="M@ Form1.cs [Design]*

0 | 3 -~ Application Configuration: |Active (Debug) v  Platform: Active (Any CPI Vv
Toolbox
Search Toolbox Build Events General
4 General Debug Conditional compilation symbols:
Resources Define DEBUG constant
Services Define TRACE constant
Settings Platform target: Any CPU v
Reference Paths Prefer 32-bit Any CPU

Signin X8
Jning [ ] Allow unsafe code
Security

|| Optimize code
Publish

Code Analysis Errors and warnings

Warning level: 4 v
21



(STEP 7)

It Is highly recommended to
re-launch Visual Studio now
then

COMPLETE THE
FIRST EMGU CV PROGRAM



Hello EmguCV with C# (1/6)
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Once the Emgu references have been setup in
VS, you can begin writing your C# code

First double click outside ImageBox area to

get Forml.cs

Then include the referenced Emgu files in

your Forms.cs file:

using Emgu.CV;

using Emgu.Util;

using Emgu.CV.Structure;

@]

Form1

=B e

23
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Hello EmguCV with C# (2/6)

Next, you will need to get an instance of the
Capture class that allow you to capture
images from your input device, inside the
Form1 class:

® Capture capture = null;

Add the Capture instance as a Class variable
since we will use it in several of the Class
methods.

24
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Hello EmguCV with C# (3/6)

Click on “Form Bar” to create Form1_ Load method

In the form’s Load method you will have to:

1. Create a new instance of the Capture class

2. Create an event handler to receive image frames
from the input device

3. Start the Capture instance

o Form1 =

private void Forml Load(object sender, EventArgs e)

{

_capture = new Capture();
_capture.ImageGrabbed += Display Captured;

// Event Handler

_capture.Start();
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Hello EmguCV with C# (4/6)

In the Capture event handler you need to:
1. Retrieve the captured image frame

2. Resize it to fit your imageBox element

3. Display the image in the imageBox

void Display Captured(object sender, EventArgs e)
{

Image<Bgr, Byte> frame =
_capture.RetrieveBgrFrame().Resize(imageBox1l.Width,

imageBox1l.Height,Emgu.CV.CvEnum.INTER.CV_INTER_LINEAR);
imageBox1l.Image = frame;

26
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Hello EmguCV with C# (5/6)

As a last step, you need to override the
onClosing method to stop the Capture

instance. This will prevent an exception from
being thrown when the program is closed.

protected override void OnClosing(CancelEventArgs e)
{

_capture.Stop();

base.OnClosing(e);

This step may be omitted in the 2.4.9beta version

27
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using System: Remove Unused Usings
4
using System.Collections.Generic;
using System.ComponentModel;
using System.Data;
using System.Drawing;
using System.Linq;
using System.Text;
using System.Threading.Tasks; 1 e
using System.Windows.Forms; -using System;
. using System.Collections.Generic;
using EmgUCV, no uEable controls using System.ComponentModel;
. 1. Jup. Drag an tem using System.Data;
using EmgU.Ut”, :i}gofd Hiothe using Svstem.Drawing:
using Emgu.CV.Structure; using S [@ View Designer Shift+F7
using S Refactor »
)} Remove Unused Usings Organize Usings »
‘i_}v Sort Usings 1 Insert Snippet... Ctrl+K, Ctrl+X
namespace e Remove and Sort %1 Surround With.. Ctrl+K, Ctrl+5
'using E X PeekDefinition Alt=F12
"= Go To Definition F12

28



using System; a5
using System.Drawing;

using System.Windows.Forms;
using Emgu.CV;

using Emgu.CV.Structure;

namespace HiEmgu

{
public partial class Forml : Form
{ Capture _capture = null;
public Forml()
{ InitializeComponent();
}
private void Forml_Load(object sender, EventArgs e)
{ _capture = new Capture();
_capture.ImageGrabbed += Display_ Captured; // Grab Event Handler
_capture.Start();
}
void Display Captured(object sender, EventArgs e)
{
Image<Bgr, Byte> frame = _capture.RetrieveBgrFrame().Resize
(imageBox1.Width,
imageBox1.Height, Emgu.CV.CvEnum.INTER.CV_INTER LINEAR);
imageBox1.Image = frame;
}
}
}

29




TROUBLE SHOOTING



Most common error: Type
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Initialization Exception

I TypelnitializationException was unhandled X
An unhandled exception of type System.TypelnitializationException” occurred in
Emgu.CV.dll
Additional information: The type initializer for ‘Emgu.CV.Cvinvoke' threw an
exception.

Troubleshooting tips:

. Get general help for this exception. | A
InnerException: Make sure you have supplied a correct file path for the assembly.
Innerkxception: Make sure the file image is a valid managed assembly.

Get general help for the inner exception. W

Search for more Help Online...

Exception settings:

[ ] Break when this exception type is thrown
Actions:

View Detalil...

Copy exception detail to the clipboard

Open exception settings

X064 selected?

DLLs are
accessible?

31
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Trouble Shooting: ‘Access
Violation’ runtime error

It may occur for the first run after setup. Re-
launch Visual Studio and/or reboot your

computer

Check if the camera is working: built-in
webcam ID is 0

32



Troubleshooting
Did you rename
anything?

Did you delete anything?
Did you double click the
imageBox?

Check Form1.Designer.cs
matches names and the
event handlers in
Form1l.cs

Are dlls set to “copy always”?

In case you use alternative
way (Step 4)

Lawrence
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Solution '"HIEmgu' (1 project)
4 ¢ HIEmgu

b M Properties

D =MW References
¢1 App.config
Hl§ cublas64 55.dll
5iF cudarte4 55.dll
HiE cuffte4_55.dll
HiE cvexterndll

E Form1.cs
> T4 Form1.Designer.cs

T_‘I Form1.resx

P ¥z Form1
28§ nppc64_55.dl
8§ nppi64_55.dIl

33
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Trouble Shooting: ImageBox
wWidth and Height values

Set a breakpoint to check the values

If different from the values set on Properties,

then change Font size setting in Control Panel -
Display to “default”.

Display

34
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Trouble Shooting: Other tips

Build -> Clean Solution
Close Visual Studio and re-launch
Restart your laptop

mageBox is not shown when running -2
~ormBar was not clicked to create Form1_Load

method, possibly

Remember: you cannot just copy and paste
whole programs! —recreate project, redesign
GUI, re-double click for each control

35
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Let’s recreate the same project

using the setup

Step 1: Name Solution/Project
Step 2 (only once): Adding ImageBox Control in VS

Step 3: Drag/drop an ImageBox on the Form
Step 4 (only once): Setup Windows path for *.DLL

Step 5: Add the three *.DLL References
Step 6: Change the ‘Platform target’ to x64

Step 7: Compete the code and change the form
bar title from Form1 to something else

36



ALTERNATIVE METHOD
FOR STEP (4) TO SETUP

JUST FOR FUTURE
REFERENCE
PLEASE DO NOT USE



Alternative way for (Step 4) - *.DLL

References (1)

To use the Emgu functions contained in multiple .dll files, they
need to be referenced in the project

Lawrence
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To reference the .dll files, right click your Project_Name in the

Solution Explorer -> Add -> Existing ltem...

New ltem...
Existing Item...

New Folder

Reference...

Ctrl+Shift+A
Shift+Alt+A

fe

Build

Rebuild

Clean

View

Analyze

Publish...

Scope to This

New Solution Explorer View
Add

Manage NuGet Packages...
Set as StartUp Project
Debug

Solution Explorer v I X

Sl e-euam|”

Search Solution Explorer (Ctrl+;) P

Solution 'HiEmgu' (1 project)
P M Properties

P =M References

¥_] App.config

A Form1.cs

> 79 Form1.Designer.cs

]’j Form1.resx
P ¥ Forml
P €% Program.cs

oL NS' @ Team Explo... Class View

ngu Project Properties -

oy 38




Alternative way for (Step 4) - *.DLL

References (i)
Navigate to C:\Emgu\emgucv-windows-universal-cuda 2.9.0.1922\bin\x64

filter by Executable Files (Enter *.dll as File Name)
Add all .dll files contained in the folder

>

©

Organize ~

25 Local Disk (C)

wdil—

* 1 | <« bin » x64

New folder

BentleyDownloads

~ [ Name

Add Existing Item - HIEmgu

ra

opencv_legacy290.dll
opencv_ml|290.dll
opencv_nonfree290.dl|
opencv_objdetect290.dll
opencv_ocl290.dll
opencv_optim290.dll
opencv_photo290.dll
opencv_softcascade290.dll
opencv_stitching290.dll

opencv_superres290.dll

v o

Search x64

Date modified
9/22/2013 7:39 PM
9/22/2013 6:38 PM
9/22/2013 9:04 PM
9/22/2013 7:38 PM
9/22/2013 7:40 PM
9/22/2013 6:38 PM
9/22/2013 10:51 PM
9/22/2013 7:38 PM
9/22/2013 10:48 PM
9/22/2013 10:59 PM

Lawrence
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Jel

- [ @

Type

Application ex
Application ex
Application ex
Application ex
Application ex
Application ex
Application ex
Application ex
Application ex

Application ex

opencv_video290.dll

9/22/2013 7:38 PM

Application ex

Civil 3D Project Tem
Civil 3D Projects
DRIVERS
eclipse
Emgu
Intel
MC11demo
MedData
MSOCache
NIFPGA
Packages ‘
PanoptoRecorder
PerfLogs =
File name;

opencv_videostab290.dll

"opencv_videostab290.dIl" "cublas64_55.dll

9/22/2013 10:59 PM

Application ex v
>

""cud: v | Visual C# Files (*.cs;*.resx;*.res' v

Add

>

Cancel

39



Alternative way for (Step 4)
- *.DLL References (iii)

Select all .dll files added in the
previous step (unselect
Forml.cs) and change the
‘Copy to Output Directory’
property to ‘Copy always’

This will copy these files to the
build directory so they can be
referenced when running your
Windows Forms application

This will make the projects bigger
but easier to get working

| Solution Bxplorer = & X
Al o-eudi

Search Solution Explorer (Ctrl+;) P~

P M Properties -

P =MW References
.1 App.config
if cublas64 55.dll
EiE cudart64_55.dll
RER cuffté4_55.dIl
iiE cvextern.dll

P Form1.cs
RiE nppc64_55.dll
REE nppi64_55.dll
RiE npps64_55.dll
RiR OpencCLdll

EHE AmAner himimemirasA30MN All

’
Class View

{
Solution Ex...

Team Explo...

Properties

az:

oDy | &

H Advanced -~
Build Action Content

el RNV Niaf Copy always Vi -

Copy to Output Directory
Specifies the source file will be copied tZi'O
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Pros/Cons of the alternative way’
“copying” *.DLL References

Advantages

® Easy release. Just copy the hole project folder to
deliver the code

® Emgu CV version independent

Disadvantages
® Complex to setup
® Project folder size becomes large (over 1.1 GB)
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